Windows SIG

September 12, 2023
Questions, Comments, Suggestions welcomed at
any time
Even Now




Audio Recording of this session
Use the link above to access MP4 audio recording

Audio Recording in Progress

SIG attendees are required to be members of the chartered club
sponsoring that SIG.

Sun City Community Association By-law

Sig leader — anyone?
SIGs
Apple Users Group
Gaming
Scams and Computer Security
Topic Suggestions — plea(se)
Your suggestions future presentations
In person meetings
Computer Club Vimeo Account
CA Vimeo Account



https://vimeo.com/863752142?share=copy

Review latest Cyber Security SIG

recording
Google Chrome extensions

VERY Sensitive information
Passwords, Credit card details,







Windows Update

EI Updates available
Last checked: Today, 12:09 PM

Windows Malicious Software Removal Tool x64d - vw5.117
(KBS890830)
Status: Installing - 0%

2023-09 Cumulative Update for NET Framework 3.5, 4.8 and
4 8.1 for Windows 10 Version 22H2 for x4 (KBE3020180)
Status: Downloading - 100%

2023-09 Cumulative Update for Windows 10 Version 22HZ2 for
¥b4d-based Systems (KBE5030211)
Status: Downloading - 1%

Wio(Nl 10




2023-09 Cumulative Update for Windows 11 Version 22H2 for x64-based Systems (KB5030219) Downloading - 7%

Windows Malicious Software Removal Tool x4 - v5.117 (KBB90830) Installing - 0%

2023-09 NET 6.0.22 Security Update for x64 Client (KB5030559) Completed

2023-09 Cumulative Update for NET Framework 3.5 and 4.8.1 for Windows 11, version 22H2 for x64 (KB5031217) Pending restart




Check for Updates




MSI confirms most are due to some
motherboard models

MSI 600/700 series
Windows Update may uninstall update




Windows backup app
Synch to OneDrive




Cumulative Update
Windows 10 KB5029331
Windows 11 KB5029351

May resolve after a few reboots
UNSUPPORTED_PROCESSOR
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Your PC ran in

to a problem and needs to restart. We'll restart for you
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Task Manager Q@ Type a name, publishe...

Processes Fe Run new task

Processes v g 47% 0%

Name CPU Memory Dis! Network

Performance
@] Desktop Window Manager 5.3%  250.5M8B 0 Mbps

App hlStOl'y > W Task Manager 2.3% 49.1 M8 0 Mbps

Sta rtup appS s Windows Explorer 0.7% 38.5 MB 0 Mbps

Wl VMware Tools ervice 0% 233 MB 0 Mbps

Users [ System interrupts 0% 0 MB 0 Mbps

Details > [@] Antimalware Service Executable 0% 1736 MB 0 Mbps
: . Service Host: Windows Manag... 0% 9.0 MB 0 Mbps
Services
. Service Host: Windows Event ... 0% 14.3 MB 0 Mbps

48 WMI Provider Host 0% 9.9 MB 0 Mbps

@ WMI Provider Host 1.7 M8 0 Mbps

TH Microsoft Teams (7) 146.3 MB 0 Mbps

f® Runtime Broker (2) 137.9 MB 0 Mbps

533 Settmgs B Microsoft Store (3) 3 0 Mbps




C:\Users\Joel>ping www.google.com

Pinging www.google.com [216.58.219.
Reply from 216.58.219.228:
Reply from 216.58.219.228:
Reply from 216.58.219.228:
Reply from 216.58.219.228:

8] with 32 bytes of data:
ime=16ms TTL=54

ime=20ms TTL=54
ime
im

1

rt r"N

rt
fede fude jude |ude
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=18ms TTL=54
e=16ms TTL=54

v non
co co

rt

Ping statistics for 216.58.219.228:

Packets: Sent = 4, Received = 4, Lost = @ (8% loss),
Approximate round trip times in milli-seconds:

Minimum = 16ms, Maximum = 28ms, Average = 17ms

C:\Users\Joel>tracert www.google.com

» fracert

Tracing route to www.google.com [216.58.219.228]
over a maximum of 30 hops:

<1 n 192.168.0.1

13 96. 126 77 .49

11 n Xxe-7-3-0- 327b7 sur@l.49thst.pa.panjde.comcast.net
12 n be-23-ar@3.newcastle.de.panjde.comcast.net
13 n hu-0-9-0- 8 ar@3.ivyland.pa.panjde.comcas

18 n be—JJ287—LP82 newyork.ny.ibone.comcast.net
16 n 68.86.84.218

16 n as27589-2.miami.fl.ibone.comcast.

17 n 216.239.62.125

18 n 64.233.174.117

16 1ga25s41-in-1228.1e1060.net [216.58.219.228]

<1 m <1
11 11
11 n 10
12 n 12
13 n 14
19 n 18 1
17 n 17
17 n 18
18 nm 18
17 n 16
18 16

S 33838
n

3 33
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Trace complete.

Wi-Fi from CMD window




» pathping

\NUsers\Jos1 >athping www . googl

Tracing route to www.ggoogle .com
over a max<imum of 10 hops:
o DESKTOP-44N9LCA [192._ 168 ._ 0.
192 . 168. 6.1
o6 120.77
xXe-7-3-0-32767 -sur9l. . A4a9thst panjde . comca:
be -2 3 MNMewcastle.de.pan comcas mNnet
O-arel . idivviland.pa. ide . com
cre2 . newvork_ ny.ibo - COmMmCan

> o= | ibonmnes . co

Computi = i c 3 - onds
N
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= |
1O - o/ = C LE&68 o
= V4
100 - - o/
e/

100 - . o S . Ssurel _44othst _pa.panjde.

100 > y, - e = < cle..de . .panjde.comcast

100 3 3 . .dvyland.pa.panjde . come
Sms / 100 -Nnewyork _ ny.ibone.comcanst
17 ms 190
LE8ms Leo % g 376 > 2758 . L | ibone
100 128
LOO

19ms 4 100 % A 2 & - 2280 1 =100 . Nnet
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» ipconfig

C:\Users\Joel>ipconfig

Windows IP Configuration

Wireless LAN adapter Wi-Fi:

Media State . -

Connection-specific DNS Suffix

Wireless LAN adapter Local Area

Media State . - -

Media disconnected

Connection™ 2:

Connection-specific DNS Suffix

Ethernet adapter Ethernet:

Connection-specific DNS
Link-local IPv6 Address
IPv4 Address. - -
Subnet Mask . = =
Default Gateway =

Ethernet adapter E

Media State . - - - - -
Connection-specific DNS

Tunnel adapter isatap.{FCEE

Media State . - - - - -
Connection-specific DNS

Tunnel adapter Teredo Tunne

Connection-specific DNS
IPv6 Address. - - - - -
Link-local IPv6 Address
Default Gateway . = = =

Media disconnected

11S:Seeb:95a4:5Saa37%s8
-e.i1ez

-255.©e

-e.1

Media disconnected

1-4204 -8F5S5F-4Cc6s4CcDe7Aese

Media disconnected

Pseudo-Interface:

>

©:9d=28:6ab8:2e58:2d97:3f57: fFfo99
:2058:2d97 :3F57 : FFo923




» getmac

C:\Users\Joel>getmac
Physical Address Transport Name

GO-FF-CB-186-15-73 Media disconnected
28-FO-76-16-E8-E2 Media disconnected
38-C9-86-21-DB-4D \Device\Tcpip {FCEE928D-4AE1-4204-8F5F-4C64CD0O7A080}

- Nslookup N

C:\Users\Joel>nslookup www.google.com
1.6.168.192.in-addr.arpa
primary name server =
responsible mail addr
serial =1
reftresh 600 (18 mins)
retry = 1260 (20 mins)
expire 684800 (7 days)
default TTL = 108806 (32 hours)
Server: UnKnown
Address: 192.168.0.1

localhost
= nobody.invalid

Non-authoritative answer:

Name : www . google.com

Addresses: 2607 :T8b0B:4006:80d: : 2604
172.217.4.68




ActT

Proto Address Foreign Address

TCP 11564 DESKTOP-44NOSLCA:1565
TCP :1565 DESKTOP-44NSLCA:1564
TCP :1566 DESKTOP-44NOLCA:1567
TCP :1567 DESKTOP-44NSLCA:1566
TCP :1589 DESKTOP-44NOSLCA:15906
TCP :1590 DESKTOP-44NSLCA:1589
TCP :1594 DESKTOP-44NSLCA:1595
TCP :1595 DESKTOP-44NSLCA:1594
TCP : 1645 DESKTOP-44NOSLCA:1646
TCP : 1646 DESKTOP-44NSLCA:1645
TCP = > bn2schB82608616548:htips HEL_SHED
TCP client:https OSE_WAIT
TCP =% i api:https CLOSE_WAIT
TCP 32 . 8.06. :159 184 .16.59.37:https ESTABELISHED
TCP 32 . 8.0. = go-in-+189:imaps ESTABLISHED
TCP 92. 8.6. = s154:imaps ABLISHED
TCP 32 . 8.0. = go-in-f189:imaps ABLISHED
TCP 32 . 8.0. = go-in-f189:imaps ABLISHED
TCP 32 . 8.0. = go-in-f189:imaps ABLISHED
TCP a2. 8.0. - . go-in-f189:imaps TABLISHED
TCP 92. 8.6. = 5 go-in-+1689:imaps ABLISHED
TCP 32 . 8.0. = go-in-f189:imaps TABLISHED
TCP 32 . 8.0. = ec2-52-22-152-92:https STABLISHED
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ABLISHED
ABLISHED
ABLISHED
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TCP 32 . 8.6. = pat-ash2:5222 ABLISHED
TCP 32 . 8.0. s ec2-52-72-156-8:https ABLISHED
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» hetsh

C:\Users\Joel>netsh /?

Usage: netsh [-a AliasFile] [-c Context] [-r RemoteMachine] [-u [DomainName\ ]JUsernNam
[Command | -f ScriptFile]

The following commands are available:

Commands in this context:

P Displays a list of commands.

add Adds a configuration entry to a list of entries.
advfirewall Changes to the "netsh advfirewall® context.
branchcache Changes to the "netsh branchcache® context.
bridge Changes to the "netsh bridge’ context.

delete Deletes a configuration entry from a list of entries.
dhcpclient Changes to the "netsh dhcpclient’® context.
dnsclient Changes to the "netsh dnsclient® context.

dump Displays a configuration script.

exec Runs a script file.

firewall Changes to the "netsh firewall® context.

help Displays a list of commands.

http Changes to the "netsh http® context.

interface Changes to the "netsh interface’ context.

ipsec Changes to the "netsh ipsec”® context.

lan Changes the "netsh lan® context.

mbn "netsh mbn® context.




C:\Users\Joel>netsh wlan /?
The following commands are available:

Commands in this context:
? Displays a list of commands.
add Adds a configuration entry to a table.
connect Connects to a wireless network.
delete Deletes a configuration entry from a table.
disconnect Disconnects from a wireless network.
Displays a configuration script.
Saves WLAN profiles to XML files.
Displays a list of commands.
Refresh hosted network settings.
reportissues Generate WLAN smart trace report.
set Sets configuration information.
show Displays information.
start Start hosted network.
stop Stop hosted network.

To view help for a command, type the command, followed by a space, and then
type 2.




C:\Users\Joel>netsh wlan show /?

The following commands are available:

Commands in this context:
all - Shows complete wireless device and networks information.
allowexplicitcreds - Shows the allow shared user credentials settings.
autoconfig - Shows whether the auto configuration logic is enabled or
disabled.
blockednetworks - Shows the blocked network display settings.
createalluserprofile - Shows whether everyone is allowed to create all
user profiles.
drivers - Shows properties of the wireless LAN drivers on the system.
filters - Shows the allowed and blocked network list.
hostednetwork - Show hosted network properties and status.
interfaces - Shows a list of the wireless LAN interfaces on
the system.
networks - Shows a list of networks visible on the system.
v onlyUseGPProfilesforAllowedNetworks - Shows the only use GP profiles on GP con
profiles - Shows a list of profiles configured on the system.
; randomization - Shows whether MAC randomization is enabled or
disabled.
¢ settings - Shows the global settings of wireless LAN.
v tracing - Shows whether wireless LAN tracing is enabled or disabled.
wirelesscapabilities - Shows the wireless capabilities of the system
; wlanreport - Generate a report showing recent wireless session information.




Revamped Photos app
Windows Backup
Microsoft Store
OneDrive




Search in addition to text

Navigation

Search ment - N
Options...
Headings Pages Results
—_ 2 Adwvanced Find...

. . . Replace...
Create an interactive outline of your document.

It's a great way to keep track of where you are or quick
maowve your content around.,

To get started, go to the Home tab and apply Heading Graphics

to the headi i d it
o £ Neadings N Your documen IHbIES
Equations
Footnotes/Endnotes

rmments

Emojis
Insert > Icons



Watermark
Design tab > Watermark

® & O

Watermark| Page Page
= Color ~ Borders

Confidential

COMNFIDEMNTIAL 1 COMNFIDEMNTIAL 2 DO NOT COPY 1

DO NOT COPY 2

"DO MOT COPY" watermark with
gray horizontal text

DO MOT COPY 2




Templates & Designs

Facet

Gallery

Integral

2o ]

Aa }

Aa]

lon Board...

Organic

Retrospect

Aa 1

-

>Aa 1

Wisp

Banded

Basis

Aa 1

2a

Aa

Circuit

Damask

Dividend

|Aa

A2y




Insert text without source formatting
CTRL + V Text-Only
Protect document with password

File > Info > Protect document > Encrypt with password

Unprotect

Encrypt with password - Clear

Transcription Audio > Text
Microsoft 365 |
Home




Text Modules autotext
Greetings

Select words > Alt + F3
Create a New Building Block
Name that Building Block
Insert by using name + F3




People
Microsoft Corporation | 6/4/2023

Advanced options

Phone Link

Microsoft Corporation | 8/3/2023




Let’s Customize Your Experience
Intent
Development Intent — Dev Home




Math Solver
Picture Dictionary
Citations
Grammer Tools
Kids Mode

Collections

Share
Save page as

Cast media to device

Read aloud

%] Math Solver

Cite this

Command Palette

Name window...

Pin to taskbar
Pin to Start

Launch taskbar pinning wizard

Browser task manager

nremet

Developer tools

Ctri+Shift+Y

Ctrl+Shift=U

Ctrl+Shift+|
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Product

Road Bkes
Rood Bies
Rode Biees

3
L
£
4

Region
Nosth
South
West

Mountain Bae Nooth
Mountain Bke West
Mountain Bie South

Whieels
Viheels
Wheels
Lights
Lights
Lignts
Brakes
Brokes
Brakes
Helmets
Heimets
Helmets
Cargo Bike
Cargo Bke
Cango Bike
Pedals
Podils
Pedals
Locks
Locks

I neke

w  Des

Nosth
West
South
West
South
Noeth
Noeth
West
South
West
South
Noeth
Sountts
Nocth
West
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West
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Nevrn
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Discount Sales
Yes

Yes

Yes

Yes

No

No

Quantity
7.78
633
5.49
1064 ¢
£.005
a.47
224
295
228
5.00
6.008
7.008
310}
4,08

Letween v

Lateg

Value

1 im

Category
57 Bikes
37 Bikes
39 Bikes
31 Bikes
42 Bikus
32 Bikes
31 Compaononts
18 Components
20 Components
16 Accessones
16 Accessoies
27 Accessones
24 Comnponenty
21 Components
2} Compononts
18 Accessories
18 Accessores
20 Accessonies
24 Bikes
23 Bikes
25 Bikes
10 Components
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14 Accessornes
13 Accessones

18 Arcaccnnias
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1 am planning o trip for our gnaiversary n
September What are some ploces we con 9o that
ore within @ 3 howr flight from London Heathrow!

oy vy

&' Designer

Describe the design you'd like to create ©

¢, Explore more prompts

create a facebook ad for a
farmers market

Ok o try s suggestion “Create & rustic Faceboo

O Addonige O Generate image




Microsoft AI-powered design tool

Edge users in US

Social Media posts, fliers, greeting cards, ...
DALL-E text-to-image

PREVIEW




Chrome 116

Chrome 2023 refresh

Google’s material & Windows 11 Mica
Chrome://flags

\ (& & Chrome chrome://flags

Experiments

Chrome Refresh p{FE]

® Chrome WebUI Refresh EREE!




& New Tab -+

C G Search Google or type a URL

Gmail Images 3%

YouTube Windows Lat.. Add shortcut




Switch your default search engine to Microsoft
Bing in Chrome.

Don't Switch

10:19
27/08/2023

Y e ) O




Bing to other browsers - reluctantly




B W ¢ v Document - WoePod
Wome  iew
04 w  waw
- B/UaxXA2 EZINR

R.I.P. Windows WordPad (1995 - 2023)




24GB decompression, 3-run avg (sec) lower is better
Intel Core i3-1125G4 2GHz 16GB DDR4-3200 NVMe SSD

200 300 400 500 600

m NanaZlP W WinRAR File Explorer ‘:’ Neowin




Notepad — auto-saving

1. Carbon, the Element —+-

Edi Vi [
dit iew Notepad automatically saves your progress. All

your content will be available the next time you

bon, the Elemen
open Notepad.

dred percent c

has the abilit

acids and DNA.

Snlpplng TooI
Win Key + Shift + S Screen snip
Win Key + Shift + R Screen Recording







IEEE 802.11be

Backward compatible

BUT NEW Devices

Faster, More connections, low latency
Less congestion & interference

Wi-Fi 6E 6 GHz band

Wi-Fi 7 2.4GHz 5GHz 6GHz

2.4GHz 11 channels 20 MHz each
5GHz 45 channels 40 MHz or 80 MHz
6GHz 60 channels 160 MHz

Wi-Fi 7 320 MHz




Quadrature Amplitude Modulation (QAM)
Wi-Fi 5 256-QAM

Wi-Fi 6 1024-QAM

Wi-Fi 7 4096-QAM

Multi-Link

Before Wi-Fi 7 each connection one band

Wi-Fi 7 multi band
Congestion & interference
Shorter range of 6 GHz




Marketing Claims

4.8 times faster

100 times lower latency
5 times network capacity

BUT Optimum Cluster controller




Router Wireless Access Point first
Backwards compatible




Tri-Band WiFi 7 Speeds up to

LED Screen

@] HomeShield

;ompatible —

=

VPN Private loT Multi-Link

Clients and Server Network Operation

Two 10G Ports

+ Four 2.5G Ports

8x
Optimally Positioned
Internal Antennas

it




Microsoft App Store
Preview

£ Dev Home fVcnchaud

Dashboard - Widget heruhigen

0% = 6.49 GB 1594 GB |  18% 3.10 Gz
ek T | Procesie
NYIOIA Sefarce GTX 10590 210 GANL%L CE 32825 M8 ‘ WhatiApp (0,26 %) Prozess beenden
= |

Nachare GPU Y p |
1329 M3 35026 WS esplorer D20 %) Prozess deenden




Remove Background
Al updates? Magic Paint

#¥ Untitled - Paint

File Edit View

Remove background



indows 11
indows Recovery Environment
Recovery Partition too small

M Dwx Mnagemere
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Paint background removal

Wi-Fi 7

RAR support

Designer Tool

Dev Home

Each larger = Recovery Partition size




Run last 5 Windows versions simultaneously
Windows 7 running on

Windows 8 running on

Windows 8.1 running on

Windows 10 running on

Windows 11

Plus DOS




B 5 E @) Windows 10 x64 - VMware Workstation
ﬂ‘ file Edit View VM Tabs Help

Recycle Bin Free
Downlo...

Windaws 8564 - ViMware Workstation

ImgBumn  Tenorshare

iCareFone
0 Meronolt ¢
The Windows

o prodected
proparty riht

VMware Logi TeraCopy
Workstati..  Options+ The predct

NTDEV

s

Notepad++  Tina-Tl

LG If,') a

Epic Games  OBS Studio  Universal x8¢
Launcher Tuning Utilit§

I

FileZilla Oracle VM
VirtualBox

Windows 7 « VMware Workstation

Windows 11 Pro Insider Preview
ild 25941.rs _prerelease.230825-1352

9.40:47 PM &,
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N ® o



VMWare Workstation
AMD Ryzen 7 5800HS

8 Zen 3 cores, 16 threads, clock boost
4.4GHz

16 GB memory




Club’s Coding SIG
Open Interpreter
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Full Screen F11
Full Screen F11
You try let the Group know




Windows Copilot




How ta Tury Qi
Dark M, »
in Windows 10/

How 10 Turm off Dark Mode in
Windows 10 in 2022

8 Tum on light mode




Windows Copilot
Modernized File Explorer Experience
Synch status and quota flyouts OneDrive
Details lane revamped

easier collaboration & file access info
Comprehensive Energy Report




gl - o X N
€ Settings
®  Test Account System > Power
- e —— ———
Energy usage .
Find a setting a View info about energy usage
|8 System Energy usage Last 24
hours
@ Bluetooth & devices
¥ Network & internet 100%
7/ Personalization
& Apps 50%
& Accounts
® Time & language /0. @ 80 89, | . o,
12:00 PM 6:00 PM 12:00 AM 6:00 AM 12:00 PM
## Gaming
X Accessibility Screen on ) Total Energy ~ Average energy
impact is between
& Privacy & security 12-and 15
@ Windows Update Screen off - Emissions Average emission
impact is between
12 and 15
Sleep -

\—‘/






Windows Copilot
Modernized File Explorer Experience
Synch status and quota flyouts OneDrive
Details lane revamped

easier collaboration & file access info
Comprehensive Energy Report

New Settings homepage




Tia Courts

Hore
Jystem
Bluetooth & devices
Network & ntesret

Personalizaton

Accounty

Time & language
Waming
Accessbilty
Privacy & secisity

Windows Update

Home

> Tia’s Laptop

Recommended settings

o Display

Personalize your device

Ethernet @ Windows Update

Cloud storage

View details

o

Never lose access to your account

Aad now

Microsoft 365 Family




Interactive cards
Grouped
Recommended Settings
Cloud Storage

Account Recovery
Personalization
Microsoft 365

Xbox
Bluetooth




» Settings & Customizations

Recycle Bin

]

Windows Backup

Backing up your PC...

This might take a few minutes, we'll let you know when the bac

DESKTOP-FTPASMM

HP Spectre x360 Convertible 13-wOXX (

Backing up
Open OneDrive
Apps Backing up.
Settings Backing up.

Credentials

Backup is more than protection m
pek O of bac

t all the benefit ackup

B Qe Ogc M @ O W@

ed Backug

144 PM

6272023 0




Backup is now an App
Requires OneDrive thus Microsoft Account




Windows Backup = O

Let's back up your PC

We'll back up your info in the cloud and automatically keep it up to date. Have peace
of mind knowing it's always protected, even if something happens to this PC.
Privacy Statement

HP Laptop 15-dy2xxx

£ Folders <
Back up files, documents, and photos to OneDrive

P Apps ' ' g
Remember installed apps and pinned app preferences

5 Settings »

Remember Windows settings and preferences

Storage estimate

126 GB cf1.05TB Cancel
]




Windows Backup -

Backing up your PC...

This might take a few minutes, we'll let you know when the backup is compiete.

HP Laptop 15-dy2xxx ES 34
Backing up...
Backup is more than protection
Check out all the benefits of backup.

Close




Folders
Apps
Settings
Credentials
CAUTION




Other windows 11 23H2 backups available
Cloud storage Cloud storage costs
Settings & Apps
File History
The Apps are Microsoft Store Apps

Not third-party apps




Full Image Backup

External disk tied to that external disk
Be there

Cloud solutions - tied to Internet
Slice(s) in time




iCloud via web & ApplelD

Web Apps vs apps

iICloud App for Windows

Apple Mail ?

iTunes -> Apple Music for Windows
Apple TV web and/or Windows App




Support ending

Microsoft Surface Duo




Microsoft will defend its AI Copilot users
Copyright lawsuits

Copyright Commitment program
Commercial customers

Reliance on Copilot filters

Few products




Split-screen layout in Edge browser
Al-enhanced moving wallpapers

Al powered file recommendations

Al review summaries Microsoft Store
Native RGB peripheral controls

File Explorer Gallery feature




tasklist

Cormmand Prompt

Microsoft windows [Version 10.6.22621
(c) Microsoft Corporation ALL raghts

\Users\arifb>tasklaist
Image Name PID

System Idle Process (2]
System a
SecCcure Systes 108
Registry b R
SmsSs . exe 588
cCsSIr'ss e x e s
wininit exe 1116
CErss.exe 1136
services . exe 1188
Lsalso. exe 1268
LSass . exe A 224
svchost . exe 1356
fontdrvhost 1384
wWUDFHOos?t exe 1448
svchost . exe 1504
svchost . exe 1552
winlogon.exe 1588
fontdrvhost _exe 1672
dwm . exe 1760
svchost 3 1788 v
svchost » 1796 Serv
svchost 1820 v
svchost 1884 v

Command Line
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Name Sessionng
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L5
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o
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e
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o
(3]
(=]
o
o
|
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|
(3]
o
e

o
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11,
7
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10,
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12,

o

124
376
328
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204
768

,B16
, 768

, 248

176
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L8052

160
o4
768

S552
528

892

268
316




» chkdsk

v, Administrator: Command Prompt - chkdsk

'.'l(‘,.‘ | 1“.Q‘.




sfc/scannow

v Administrator: Command Prompt - sfc /scannow




. Diskpart

<. Administrator: Command Prompt - Diskpart

sOoft lindows |[Version 10.0.2262

"iHl’lY <

1©.0.22621.1

Corporation.
TOPST







» systeminfo

T+ Administrator: Command Prompt










Microsoft to drop third-party printer driver
updates from Windows Update

Xbox Mastercard

Microsoft Event October 3
OneDrive offline mode?







None of us are as experienced as all of us
Awareness, Preparedness, Understanding
Participate

Topic Suggestions

Questions: scccwindows@gmail.com
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